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Windows XP Additions
to

NDF Trouble Shooting

Error Messages
Error Message When Starting From a Desktop Icon
Problem: NDF encounters a runtime error immediately on startup, when started from a desktop

icon.
Cause: Desktop icon may not have been created correctly.
Solution: Verify desktop icon.

Windows XP
1. Right click on the NDF icon, select “Properties”.
2. Click “Shortcut” tab.  The shortcut target should resemble the illustration shown previously,

(drive letter may not be “C”).

If the shortcut target does not resemble the illustration, delete the shortcut and follow correct
instructions for creating desktop icon, as follows:
1. From “Start”, choose “All Programs”,
2. Then choose “NDF Electronic Forms”,
3. Right click on your program (County/District Attorney, Municipal, Civil, or whatever program

you have), then click “Create Shortcut”.
4.  Then click on “NDF-(your program group) (2)” and drag it to the desktop.

Error Message When Working in the Program (System Resources)
Problem: You get an error message when working in the program.
Cause: Computer does not have enough in System Resources (memory in Random Access

Memory “RAM”) available to handle the program.
Solution: Close programs that are not in use to make more RAM available for the use of the

NDF Electronic Forms Program.  Please note that the NDF Electronic Forms
Program can require up to 24 mg’s for RAM with Windows 95, 32 mg’s of RAM with
Window 98 and 48 to 64 mg’s of RAM with Windows 2000 or Windows XP.

System Resources
Windows XP
Windows XP is set up a little different from other Windows program, in that you can use some of
your hard drive when you do not have enough RAM for the programs that you are running.  For
best performance, do not set the initial size to less than the minimum recommended size under
“Total paging file size for all drives”.  The recommended size is equivalent to 1.5 times the
amount of RAM on your system.  Usually, you should leave the paging file at its recommended
size, although you might increase its size if you routinely use programs that require a lot of
memory.
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1. From “Start”, choose “Control Panel”,
2. Then choose “Performance and Maintenance”,
3. Then click “System”.
4. On the “Advanced” file tab, under “Performance”, click “Settings”.
5. On the “Advanced” file tab, under “Virtual memory”, click “Change”.
6. Under “Drive [Volume Label]” click the drive that contains the paging file you want to

change.
7. Under “Paging file size for selected drive”, click “Custom Size”, and type a new paging file

size in megabytes in the “Initial size (MB)” or “Maximum size (MB)” box, and then click “Set”.
If you decrease the size of either the initial or maximum page file settings, you must
restart your computer to see the effects of those changes.  Increases typically do not
require a restart.

NDF Runtime Error During Update Installation
Problem: NDF Runtime errors occur while installing an update.
Cause: NDF Installation Program cannot locate the data and print credit files from the

original installation.
Solution: Install the update to the same location as the original program.

Windows 95, Windows 98, Windows NT or Windows XP
Check the location of your original program that you are working in (see Update Installation,

Page 21 of this manual).  Reinstall the update to the correct location.
Sometimes Windows will move files to another drive, if the designated drive is too full.  You

may need to move the original NDF Program files to another drive and reinstall the update to
that location.

It may be helpful to run the Disk Defragment Program, if you have not done so in a while.
See your Windows manual or help menu for directions, or refer to “Printing Problems:  Improper
Printout or Not Printing Form Correctly” in this manual to find directions on the Disk Defragment
program.

Printing Problems
Improper Printout or Printing Blank Forms from HP Printers
Problem: You have problems with improper printout, the form prints, but data is missing when

printed from an HP Printer.
Cause: Meta files are not handled as transparent on all HP Printer drivers, they are

programmed to appear transparent with the data entry file located underneath,
printing at the same time.

Solution: We recommend the printer use the generic HP driver (not the print driver for your
specific printer model).  If you have an Hewlett Packard Printer chances are you are
using the printer driver from Hewlett Packard that is specifically for your printer
model and it causes problems.  Experience has shown that the generic Hewlett
Packard driver usually works.  You can do this one of two ways.
First, you can change the print driver so that all printing uses the generic print driver.
Sometimes this can cause problems with printing from other programs.
The alternative is to add a printer to your list of printers and modify that particular
printer for use with the NDF Program.  You would need to be sure to designate it as
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the NDF printer and also to choose the NDF printer as the default printer before you
go into the NDF Program.  The Electronic Forms Program always prints to the
default printer.   
To make switching back and forth from one driver to another easier, you can create
shortcut icons for each printer for your desktop (see section below Creating Printer
Shortcut Icon).  NDF will always print to the default printer.  So before entering the
NDF Program double click on the NDF Printer Icon on your desktop and click on
“Printer” on the tool bar, then choose “Set as Default Printer”.

Change your Print Driver

Windows XP
1. From “Start”, choose “Control Panel”.
2. Choose “Printers and Faxes”.
3. Then under the “Advanced” file tab choose “New Driver” button.
4. The “Print Driver Wizard” appears choose “Next”.
5. Then select a new driver (generally model specific printers do not work as well as generic

printers).  Choose “Next”.

Add Printer

Windows XP
1. From “Start” choose “Control Panel”.
2. Then select “Printers and Other Hardware”.
3. Under “Pick Task”, choose “Add Printer”
4. The Add Printer Wizard comes up.  Choose “Next”.
5. Choose whether it is local printer or network printer and click on “Next”.
6. The Printer Wizard will tell you that it cannot “Detect any Plug & Play printer.  To install the

printer manually click Next”.  Click “Next”.
7. Indicate the same port at the HP Printer is currently hooked up to, normally this is LPT1.

Choose “Next”.
8. On the Right side of the next window, choose the manufacturer as HP.  In the Printer

Column choose HP DeskJet, HP CopyJet, HP Color LaserJet, HP OfficeJet, HP Paint Jet or
HP QuietJet.  Just the name, with no model number or other words.  Then choose “Next”.

9. Rename the printer to NDF Printer.  Choose “Next”.
10. Since you are already using your printer, you do not need to print a test page, select “No” &

“Next”.  Then click “Finish”.

Create Printer Shortcut Icon

Windows XP
1. When you return to the “Printers and Faxes” folder, right mouse click on the NDF Printer and

choose “Create Shortcut”
2. You will get the message “Windows cannot create a shortcut here.  Do you want the

shortcut to be placed on the desktop?”  Choose “Yes”.
3. Follow steps 1 & 2 for the other HP Printer.
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Improper Printout or Not Printing Form Correctly
Problem: You have problems with improper printout, only part of a page prints or not all pages

from a form set print.
Cause: Your hard drive may need to be checked for problems with the drive or you may

need to defragment your hard drive.
Solution: Run the scan disk program to see if there are any errors and then run the disk

defragmenter program to reorganize the hard drive so that all of each program will
be on the same place in the hard drive.  If you have more than one hard drive you
should perform scan disk and disk defragmentation on each drive.

Windows XP
Scan Disk
1. From “Start” choose “My Computer”.
2. Then select the hard drive you need to scan.
3. From the “File” menu on the tool bar, choose “Properties”.
4. On the “Tools” tab, under “Error Checking”, click “Check Now”.
5. Under “Check Disk Options”, select the “Scan for and attempt recovery of bad sectors”

check box.
6. Click on the “Start” button.
Disk Defragment
1. From “Start” then choose “Programs”.
2. Choose  “Accessories”.
3. Choose “System Tools”.
4. Then choose “Disk Defragmenter”.
5. Click on the “Defragment” button.

Printing Too Many Copies
Problem: You request one copy of a form, but more print out.
Cause: Printer copies may be set to a number other than 1.
Solution: Check the printer setting by using the appropriate method for your operating system.

Windows XP
1. From “Start” choose “Control Panel”,
2. Then “Printers and other Hardware”,
3. Under “Pick a Control Panel Icon” choose “Printers and Faxes”,
4. Click once on the printer you are using and in the “Printer Tasks” box on the right side of the

screen, choose “Set Printer Properties”.  Under the “Advanced” file tab, choose “Printer
Defaults”.

5. Check under Print job and be sure the copy number is set to 1.  If not, change it to 1 and
click on the “OK” button.  Then click on the “OK” button again.
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Slow Printing or Not Printing the Form Correctly
Problem: Slow printing or the form does not print correctly.
Cause: Installed printer memory is set incorrectly.  Your computer may not be set to

recognize all of the memory available in your printer or it may attempt to recognize
more memory than is present in the printer

Solution: Change the installed printer memory setting by using one of the following methods.
 Your computer should usually be set to recognize all of the memory in your printer, but not

more.  To print our forms a 300 dpi laser printer needs 1 1/2 MB of printer memory. A 600 dpi
laser printer needs 4 MB.

Setting Memory for Printer
Windows XP
1. From “Start”, choose “Control Panel”,
2. Then choose “Printers and other hardware”,
3. Under “Pick a Control Panel Icon” choose “Printers and Faxes”,
4. Right click on the icon for the printer you are using, then click “Properties”,
5. On the “Device Settings” tab, under “Installable Options”, the click “Printer Memory”,
6. Then click the number that matches the amount of memory installed in your printer or

plotter.
Your printer has memory chips for storing information that is sent to it.  When you install
a printer, Windows reads the amount of printer memory so the printers and windows
work properly together.  When you install additional memory into your printer, you need
to change the printer memory setting in Windows so that the two match.  If Windows is
set to expect more or less memory than actually resides in your printer, Windows may
display a memory message or work improperly.

Will Not Print - Wrong Paper Size Indicated
Problem: Printer indicates that it needs legal sized paper and will not print.
Cause: Computer settings may be set to wrong sized paper.
Solution: Check the printer settings by using the appropriate method for your operating

system.

Windows XP
1. From “Start” choose “Control Panel”,
2. Then “Printers and other Hardware”,
3. Under “Pick a Control Panel Icon” choose “Printers and Faxes”,
4. Click once on the printer you are using and in the “Printer Tasks” box on the right side of the

screen, choose “Set Printer Properties”.
5. Under the “Advanced” file tab, choose “Printer Defaults”.
6. Check under size choose paper size “Letter (8 1/2 x 11 in)” by clicking on the correct icon.

Make sure the page orientation is set to “Portrait”.  Click on the “OK” button.
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Screen Display
Incomplete Form
Problem: Form appears in an incomplete format.  For example words or lines or parts of them

are missing.
Cause: Insufficient memory for screen display in the number of colors and resolution

specified in your Windows program.
Solution: Try changing colors and resolution settings from 800 x 600 to 640 x 480, by using

one of the following methods.  This may also resolve an associated printing problem.

Windows XP
1. From “Start”, choose “Control Panel”.
2. Then choose “Appearance and Themes”.
3. Under pick a task choose “Change the screen resolution”.
4. Under the “Settings” file tab, adjust the “Screen resolution” box to fewer pixels. Click “OK”.

Incomplete Form (additional possible solution for Windows XP)

Problem: Form appears in an incomplete manner.
Cause: Screen oddities can be caused by problems with video optimization.
Solution: Reduce hardware acceleration.

Windows XP
1. From “Start”, choose “Control Panel”.
2. Then choose “Appearance and Themes”
3. Under pick a task choose “Change the screen resolution”.
4. Choose the “Advanced” button under the “Troubleshooting” file tab.  Reduce the “Hardware

Acceleration” .
5. Click on “OK”.
6. Then click on “OK” again.

Improper Screen Display
Problem: You have problems with improper screen display such as part of a form disappears

when scrolling down.
Cause: Your hard drive may need to be checked for problems with the drive or you may

need to defragment your hard drive.
Solution: Run the scan disk program to see if there are any errors and then run the disk

defragmenter program to reorganize the hard drive so that all of each program will
be on the same place in the hard drive.  If you have more than one hard drive you
should perform scan disk and disk defragmentation on each drive.

Windows XP
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Scan Disk
1. From “Start” choose “My Computer”.
2. Then select the hard drive you are needing to scan.
3. From the “File” menu on the tool bar, choose “Properties.
4. On the “Tools” tab, under “Error Checking”, click “Check Now”.
5. Under “Check Disk Options”, select the “Scan for and attempt recovery of bad sectors”

check box.
Disk Defragment
1. From “Start” then choose “Programs”.
2. Choose  “Accessories”.
3. Choose “System Tools”.
4. Then choose “Disk Defragmenter”.
5. Click on the “Defragment” button.


